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GRAPE M1 
 

Introduction 
A high precision 3-dimensional modelling software windows® application that enables designers to 
construct an accurate model based on the construction and subsequent assembly of detailed model 
layers. 
 
Based on our proprietary 3D modelling data format Graphical Rectangular Actual Positional Encoding 
GRAPE™ each model layer is constructed from a collection of solid rectangles. The modelling 
software provides a suite of “Structure Entity Enhanced Design” constructs (for example a circle 
formed by a collection of rectangles) that the designer can further manipulate. Each model rectangle 
can be individually selected/highlighted to delete or move; together with visual inspection of the 
rectangle’s positional points XYZ. 
 
Model layers and the overall structure model are saved to files in both GRAPE™ and STL data 
formats; to enable the model to be printed on Copner Biotech Bio Printers using GRAPE™ 3D printing 
method and by other vendor 3D printing devices that accept STL. 
 
Utilizing Copner Biotech’s bioprinters these models can be accurately printed RENDERABLE 
BIOFABRICATION™ with high batch to batch consistency essential for research activities. 
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Application Launch 
GRAPE M1 when launched displays an initial splash screen Figure 1 GRAPE M1 Splash Screen in the 
‘Model Designer’ frame which fades out presenting Figure 2 GRAPE M1 Scaffold and Layer Model 
Canvases – Print Preview pane and Bed parameters 
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Figure 1 GRAPE M1 Splash Screen 

 

 

Figure 2 GRAPE M1 Scaffold and Layer Model Canvases – Print Preview pane and Bed parameters 

Application can be minimised using its windows® control or pressing ‘Esc’ key 

Printer Bed 
This dialog presents ‘Draw Metrics’ which the designer can configure:  

• dimensions of their printer bed printable volume.  
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• printer bed origin position X and Y which forms the centre point from which subsequent 

model constructs are drawn relative to this configurable origin. 

• thickness of lines employed to create model constructs. 

• delta movement of (selected for move) model constructs on action of the keyboard 

left/right/up/down arrow keys. 

Print Preview 
This panel shows the actual printer bed position(s) of model construct(s) drawn; together with 

current configured draw origin position and bed dimensions. 

Model Layer 
On selecting the ‘Model Layer’ notebook leaf the designer is presented with the ‘Model Layer’ 
canvas that enables a model layer to be constructed. 
 
Right clicking the mouse displays a palette of “Structure Entity Enhanced Design” constructs that the 
designer can individually select, configure and draw; Figure 3 Layer Model Structure Entity Enhanced 
Design Draw Constructs - Select Origin 
 

 
Figure 3 Layer Model Structure Entity Enhanced Design Draw Constructs - Select Origin 

Layer Origin 
Before constructing the model layer; the designer must select the model layer origin by right clicking 
the mouse on the layer canvas and selects to configure the draw origin using the pop-up menu 
Figure 3 Layer Model Structure Entity Enhanced Design Draw Constructs - Select Origin. The origin is 
the central position on the printer bed that the drawing aids use as a reference point; for example 
the centre point of a circle to be subsequently drawn around. Note GRAPE M1 outputs models in 
both STL (unit dimensionless) and GRAPE (units mm). 
 
Copner Biotech bioprinter GRAPE measurements are in mm and this unit of measurement will be 
used throughout this document. 
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On selection of Draw->Origin the designer is presented with a dialog to enter subsequent draw 
origin X and Y coordinates Figure 4 Select Layer Origin Printer Bed Coordinates.  Default values for X 
and Y origin coordinates are X 100.0 mm (allowable range 0.0 to PlateXY dimension value mm) and Y 
100.0 mm (allowable range 0.0 PlateXY dimension value mm} the designer can either overwrite 
these values or adjust the values using the spin controls (allows adjustments in 0.01mm); before 
actioning ‘Create’ to apply these new values or selecting ‘Cancel’ to abort changes and keep the 
previous settings. 
 
Draw origin X and Y can also be adjusted via the ‘Draw Metrics’ ‘Origin X’ and ‘Origin Y’ dialogs. 
 

 
Figure 4 Select Layer Origin Printer Bed Coordinates 

 

Circle Construct 
A circle construct layer model can be constructed around the currently selected printer bed origin. 
The designer right clicks the mouse on the layer canvas and selects to draw a circle using the pop-up 
menu Figure 5 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Circle. 
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Figure 5 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Circle 

 

On selection of Draw->Circle->Circle the designer is presented with a dialog to enter subsequent 
draw circle parameters Figure 6 Select Layer Circle Creation Parameters . 
 

 
Figure 6 Select Layer Circle Creation Parameters 

Utilising this dialog the designer can specify the circle radius (range 0.01 to 60.0) (with 0.01 mm 
adjustment resolution) and rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm 
adjustment resolution) together with the arc angle (degrees with 0.25 resolution). All entry dialogs 
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can be overwritten or adjusted using the spin controls. The arc angle in degrees together with the 
radius dictates the length of the rectangle/line components employed to draw the polygon circle.  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required circle Figure 7 
Circle Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Top View 
 

 
Figure 7 Circle Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Top View 

 

The designer can rotate displayed constructs by clicking and holding down the left mouse on the 
layer canvas and dragging the mouse up/down/left/right Figure 8 Circle Construct with 6.2mm 
Radius 0.2mm thickness and Arc Angle 10 degrees - Rotated View 
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Figure 8 Circle Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Rotated View 

 

The designer can zoom a displayed construct by operating the mouse wheel whilst on the layer 

model canvas; forward wheel rotation to zoom in and vice versa Figure 9 Circle Construct with 

6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Rotated and Zoomed View 

 

Figure 9 Circle Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Rotated and Zoomed View 
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Erase Canvas 
Canvas can be erased of constructed/drawn model constructs by right clicking the mouse on the 
canvas and selecting ‘Erase’ from the pop-up menu Figure 10 Select to Erase Model Constructs 
 

 
Figure 10 Select to Erase Model Constructs 

Reset Canvas 
Constructed and displayed models that have been rotated and/or zoomed can be conveniently reset 

to their non-zoomed top view by right clicking the mouse on the canvas and selecting ‘Reset’ Figure 

11 Select to Reset Model Constructs. In this example to circle construct will be re-displayed as a top 

view. 
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Figure 11 Select to Reset Model Constructs 

 

Disc Construct 
A disc construct layer model can be constructed around the currently selected printer bed origin. 
The designer right clicks the mouse on the layer canvas and selects to draw a disc using the pop-up 
menu Figure 12 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Disc 
 

 
Figure 12 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Disc 
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On selection of Draw->Circle->Disc the designer is presented with a dialog to enter subsequent draw 
circle parameters Figure 13 Select Layer Disc Creation Parameters. 
 

 
Figure 13 Select Layer Disc Creation Parameters 

 
Utilising this dialog the designer can specify the circle/disc radius (range 0.01 to 60.0) and 
rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution) together 
with the arc angle (degrees with 0.25 resolution). All entry dialogs can be overwritten or adjusted 
using the spin controls. The arc angle in degrees together with the radius dictates the length of the 
rectangle/line components employed to draw the polygon circle.  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required disc Figure 14 
Disc Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Top View 
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Figure 14 Disc Construct with 6.2mm Radius 0.2mm thickness and Arc Angle 10 degrees - Top View 

 

Inverse Model Construct 
The designer can also select to create rectangular constructs that will serve to encapsulate the 

constructs of a model layer. 

This feature is useful for creating a model layer mould for subsequent filling of the mould voids with 

low viscosity BioInks. 

This inverse border feature is also useful for protecting the model whilst in transit or storage prior to 

its removal and model use. For example low viscosity BioInks can be encased in gelatine to allow 

post print crosslinking and then the gelatine melted away prior to deploying the model. For example 

inverse of disc model layer;  Figure 15 Model Layer with disc model and Inverse model selection 
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Figure 15 Model Layer with disc model and Inverse model selection 

 

On selection of the inverse model option the software will encapsulate the disc model layer 

currently displayed on the ‘Model Designer’ canvas. Using the ‘Model Encapsulation’ parameters 

defined in the ‘Printer Bed’ settings; the software uses the ‘Print Lines’ parameter together with the 

‘Draw Metrics’ ‘Thickness’ selection to calculate the ‘Model Border’ setting. ‘Model Border’ is 

determined by multiplying the ‘Print Lines’ with ‘Thickness’ parameter values; and the software uses 

this to create a square around the model to be encapsulated. Figure 16 Inverse disc model layer with 

0.4mm border 
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Figure 16 Inverse disc model layer with 0.4mm border 

 

Similarly the designer can create the inverse of any created model layer; for example a mesh Figure 

17 Mesh Model Layer Figure 18 Select to create inverse mesh model Figure 19 Inverse mesh model 

with 0.4mm border Figure 20 Inverse mesh model layer rotated and zoomed 

 

Figure 17 Mesh Model Layer 
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Figure 18 Select to create inverse mesh model 

 

Figure 19 Inverse mesh model with 0.4mm border 
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Figure 20 Inverse mesh model layer rotated and zoomed 

 

Draw Mesh 
A mesh construct layer model can be constructed around the currently selected printer bed origin. 

The designer right clicks the mouse on the layer canvas and selects to draw a mesh using the pop-up 

menu Figure 21 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Mesh 

 

Figure 21 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Mesh 
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On selection of Draw->Mesh the designer is presented with a dialog to enter subsequent mesh 
construct parameters Figure 22 Select Layer Mesh Creation Parameters 
 

 
Figure 22 Select Layer Mesh Creation Parameters 

Utilising this dialog the designer can specify: 

• mesh offset point X & Y coordinates from the current configured origin (range -60.0 to 
+60.0) in mm (with 0.01 mm adjustment resolution) 

• rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution)  

• mesh line length (range 0.01 to 60.0) in mm (with 0.01 mm adjustment resolution) 

• mesh line spacing (range 0.01 to 9.95) in mm (with 0.01 mm adjustment resolution) 

• number of mesh lines (range 2 to 6000 with 1 adjustment resolution) 
All entry dialogs can be overwritten or adjusted using the spin controls  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required mesh Figure 23 
Mesh Construct X 5.0 mm Y -10mm thickness 0.2 mm length 10 mm spacing 0.8 mm and number 
lines 10 – Rotated and Zoom View 
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Figure 23 Mesh Construct X 5.0 mm Y -10mm thickness 0.2 mm length 10 mm spacing 0.8 mm and number lines 10 – 
Rotated and Zoom View 

 

Draw Line Offset 
A line can be constructed and drawn at an offset point location from the currently defined printer 
bed origin. 
 
The designer right clicks the mouse on the layer canvas and selects to draw an offset line using the 
pop-up menu Figure 24 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Line 
Offset 
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Figure 24 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Line Offset 

On selection of Draw->Line->Offset the designer is presented with a dialog to enter subsequent line 

construct parameters Figure 25 Select Layer Line Offset Creation Parameters 

 

 

Figure 25 Select Layer Line Offset Creation Parameters 

Utilising this dialog the designer can specify: 

• line offset point X & Y coordinates from the current configured origin (range -60 to +60.0) in 
mm (with 0.01 mm adjustment resolution) 
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• rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution)  

• line length (range 0.01 to 60.0) in mm (with 0.01 mm adjustment resolution) 

• line slope angle (range -180 to +180) degrees (with 0.1 degree adjustment resolution) 
 
All entry dialogs can be overwritten or adjusted using the spin controls  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required line Figure 26 
Offset Line Construct  X offset 5mm Y offset -10 mm thickness 0.2 mm length 10 mm slope angle 0 
degrees - Top View 
 

 
Figure 26 Offset Line Construct  X offset 5mm Y offset -10 mm thickness 0.2 mm length 10 mm slope angle 0 degrees - Top 
View 
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Figure 27 Offset Line Construct  X offset 5mm Y offset -10 mm thickness 0.2 mm length 10 mm slope angle 45 degrees - Top 
View 

Draw Radial Line 
A line can be constructed and drawn from the circumference of a circle (internal data representation 
of a circle of the specified radius centred around the printer bed origin) towards the currently 
defined printer bed origin. 
 
The designer right clicks the mouse on the layer canvas and selects to draw a radial line using the 
pop-up menu Figure 28 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Line 
Radial 
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Figure 28 Layer Model Structure Entity Enhanced Design Draw Constructs - Draw Line Radial 

On selection of Draw->Line->Radial the designer is presented with a dialog to enter subsequent line 

construct parameters Figure 29 Select Layer Line Radial Creation Parameters 

 

Figure 29 Select Layer Line Radial Creation Parameters 

Utilising this dialog the designer can specify: 

• radius of calculated circle circumference from the current configured origin (range 0.01 to 
60.0) in mm (with 0.01 mm adjustment resolution) 

• rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution)  

• line length (range 0.01 to 60.0) in mm (with 0.01 mm adjustment resolution) 
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• line arc angle (range 0 to 360) degrees (with 0.1 degree adjustment resolution) 
 
All entry dialogs can be overwritten or adjusted using the spin controls  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required line. 

An example of 3 radial lines drawn at arbitrary arc angles 60/120/270 degrees using calculated circle 

circumference of 8.4 mm; line thickness 0.2 mm and length 5.6 mm are depicted in Figure 30 Radial 

Line Constructs Circle Radius 8.4 mm thickness 0.2 mm length 5.6 mm arc angles 60/120/270 

degrees - Top View 

 

 

Figure 30 Radial Line Constructs Circle Radius 8.4 mm thickness 0.2 mm length 5.6 mm arc angles 60/120/270 degrees - Top 
View 

 Draw Parallel Lines 
Parallel lines can be constructed and drawn at an offset point location from the currently defined 
printer bed origin. 
 
The designer right clicks the mouse on the layer canvas and selects to draw parallel lines using the 

pop-up menu Figure 31 Layer Model Structure Entity Enhanced Design Draw Constructs – Draw Line 

Parallel 
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Figure 31 Layer Model Structure Entity Enhanced Design Draw Constructs – Draw Line Parallel 

On selection of Draw->Line->Parallel the designer is presented with a dialog to enter subsequent line 
construct parameters Figure 32 Select Layer Line Parallel Lines Creation Parameters 
 

 
Figure 32 Select Layer Line Parallel Lines Creation Parameters 

Utilising this dialog the designer can specify: 

• line offset point X & Y coordinates from the current configured origin (range -60 to +60.0) in 
mm (with 0.01 mm adjustment resolution) 

• rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution)  

• line length (range 0.01 to 60.0) in mm (with 0.01 mm adjustment resolution) 
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• line slope angle (range -90 to +90) degrees (with 0.1 degree adjustment resolution) 

• Line Spacing X and Y Components (range 0.0 to 5.0) in mm (with 0.01 mm adjustment 
resolution 

• Number of parallel lines (range 2 to 6000) 
 
All entry dialogs can be overwritten or adjusted using the spin controls  
 
Selecting ‘Create’ realises the construction and subsequent drawing of the required parallel lines 

Figure 33 Parallel Lines Construct  X offset 5.0mm Y offset -10.0mm Thickness 0.2mm Length 5.6mm 

Slope Angle 30 degrees X Spacing 0.0mm Y Spacing 1.0mm Number Lines 2 

 

 

Figure 33 Parallel Lines Construct  X offset 5.0mm Y offset -10.0mm Thickness 0.2mm Length 5.6mm Slope Angle 30 degrees 
X Spacing 0.0mm Y Spacing 1.0mm Number Lines 2 

 

Freehand Drawing 
Lines can be drawn by the designer using the ‘Drawing Print Preview Panel‘ launched by pressing the 

‘Insert’ key whilst the Model Layer->Model Designer panel has focus. The Model Layer->Model 

Designer panel can obtain focus when the designer clicks the left mouse key whilst the mouse is 

positioned inside the ‘Model Designer’ panel. 

The ‘Drawing Print Preview Panel’ can also be accessed on selection of Draw->Line->Freehand; 
Figure 34 Layer Model Structure Entity Enhanced Design Draw Constructs – Draw Line Freehand 
where the designer is presented with a dialog to enter subsequent line construct thickness Figure 35 
Select Draw Line Thickness Parameter. On subsequent selection of select the ‘Drawing Print Preview 
Panel’ is displayed Figure 36 Drawing Print Preview Panel. 
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The displayed ‘Drawing Print Preview Panel’ can be removed by pressing the ‘Insert’ key whilst the 
mouse position is within the ’Drawing Print Preview Panel’. 
 

 
Figure 34 Layer Model Structure Entity Enhanced Design Draw Constructs – Draw Line Freehand 

 

 

Figure 35 Select Draw Line Thickness Parameter 

Utilising this dialog the designer can specify: 

• line draw thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution) 
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Figure 36 Drawing Print Preview Panel 

Movement of the mouse with in the ‘Drawing Print Preview Panel’ is tracked to show its actual print 

bed positional coordinates displayed as Cursor X & Y Figure 37 Drawing Print Preview Panel - Cursor 

Position 

 

Figure 37 Drawing Print Preview Panel - Cursor Position 
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Drawing can be realised by clicking and holding the mouse Left button whilst moving the mouse 

Figure 38 Drawing Print Preview Panel - Constructs Drawn. 

 

Figure 38 Drawing Print Preview Panel - Constructs Drawn 

On selection of the ‘Insert’ key whilst ‘Drawing Print Preview Panel’ is in focus;  the ‘Drawing Print 

Preview Panel’ closes down to show the drawn constructs on the ‘Model Designer’ panel Figure 39 

Model Designer - Constructs Drawn to allow further editing/manipulation – see section Modification 

of Layer Constructs. 
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Figure 39 Model Designer - Constructs Drawn 

Modification of Layer Constructs 
Draw Layer constructs can be further inspected and edited such that the designer can: 

• Verify a construct’s position and dimensions 

• Move a construct’s position  

• Delete a construct 

• Adjust a construct’s dimensions thickness and length together with the construct’s X and Y 

offsets and slope angle 

Verification of a Construct’s position and dimensions 

The designer can highlight using the mouse; the model layer rectangular construct of interest and 

verify is position and dimensions from the pop-up dialogs; Figure 40 Rectangular Construct 

Positional Point Information; 
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Figure 40 Rectangular Construct Positional Point Information 

The designer can move a highlighted rectangular construct by using the keyboard arrow keys; Figure 

41 Adjust Placement of Layer Constructs using the Left/Right/Up/Down keys 

 

 

Figure 41 Adjust Placement of Layer Constructs using the Left/Right/Up/Down keys 

The designer can delete a highlighted rectangular construct; Figure 42 Deletion of Layer Constructs 
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Figure 42 Deletion of Layer Constructs 

 

The designer can modify a construct’s dimensions and slop angle post initial drawing by right clicking 

the mouse whilst the construct is highlighted; Figure 43 Construct modification Dialog which initially 

presents the Construct's current properties 

 

 

Figure 43 Construct modification Dialog which initially presents the Construct's current properties 
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Utilising this dialog the designer can specify: 

• line offset point X & Y coordinates from the current configured origin (range -60 to +60.0) in 
mm (with 0.01 mm adjustment resolution) 

• rectangle/line thickness (range 0.01 to 9.99) in mm (with 0.01 mm adjustment resolution)  

• line length (range 0.01 to 60.0) in mm (with 0.01 mm adjustment resolution) 

• line slope angle (range -180 to +180) degrees (with 0.1 degree adjustment resolution) 
 
All entry dialogs can be overwritten or adjusted using the spin controls; Figure 44 Construct 
Modification Dialog now showing the required adjustment settings 
 

 

Figure 44 Construct Modification Dialog now showing the required adjustment settings 

Selecting ‘Create’ realises the construction and subsequent redrawing of the required line; Figure 45 

Construct Modification now completed by redrawing the construct with the new settings 

 



 
 

33 
GRAPE M1 Modelling Software User Manual v3_01 – Copyright © Copner Biotech Ltd 2024 

 

Figure 45 Construct Modification now completed by redrawing the construct with the new settings 

 

Saving a Model Layer 
On completion of a Model Layer construction the designer can save this to a file using the pop-up 

menu; Figure 46 Save Model Layer 

 

 

Figure 46 Save Model Layer 
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On action of the ‘Save File’ the designer is presented with a dialog to select filename and location to 

save; Figure 47 Save File Selection Dialog 

 

 

Figure 47 Save File Selection Dialog 

 

On actioning ‘Save’ the model layer is saved; Figure 48 Model Layer saved in both GRAPE and STL 

data formats. 

GRAPE data format for use with Copner Biotech’s GRAPE family of 3D bio printers; e.g. GRAPE S1 

STL data format for conventional 3D printers; useful for visualising your 3D bio construct in plastic. 

Note: Ensure the selected file folder name has no spaces 

 

 

Figure 48 Model Layer saved in both GRAPE and STL data formats 

 

Open a Model Layer 
The designer can select previously saved model layers;  Figure 49 Open previously saved Model 

Layer 
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Figure 49 Open previously saved Model Layer 

Designer is presented with a dialog; Figure 50 Select Model Layer GRAPE file to load 

 

NOTE: GRAPE M1 will only read in GRAPE .cbl files; but will save model layers is both GRAPE and STL 

formats 

 

Figure 50 Select Model Layer GRAPE file to load 



 
 

36 
GRAPE M1 Modelling Software User Manual v3_01 – Copyright © Copner Biotech Ltd 2024 

On selection of ‘Open’ the previously saved GRAPE file is loaded and displayed; Figure 51 Model 

Layer loaded and displayed. 

Note: Ensure the selected file folder name has no spaces 

 

 

 

Figure 51 Model Layer loaded and displayed 

 

Model Layer Construct Manipulation 
Designer can also select specific rectangles of a model construct to be manipulated;  

Using the ‘Drawing Print Preview Panel’ a designer can move/copy/delete construct(s) to fine tune 

the model layer under construction; Figure 52 Model Layer Drawing Print Review Panel 
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Figure 52 Model Layer Drawing Print Review Panel 

 

All the model manipulation features that are documented below for assembled models are available 

for the Model Layer; Delta Move/Copy & Paste/Delete. Figure 53 Model Layer select rectangular 

constructs 

Construct(s) can be selected by pressing and holding the middle mouse button and drawing a box 

around the construct to be selected to be moved/copied/deleted. Selected constructs are 

highlighted in blue. 

Deletion of selected model rectangle constructs can be achieved using this workflow example; 
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Figure 53 Model Layer select rectangular constructs 

 

Selected model layer can be deleted using the popup menu Figure 54 Model Layer Select to delete 

constructs 

 

 

Figure 54 Model Layer Select to delete constructs 
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On action of ‘Delete’ the selected constructs are deleted Figure 55 Model Layer demonstrating 

deleted constructs and Figure 56 Model layer disc model with deleted constructs 

 

Figure 55 Model Layer demonstrating deleted constructs 

 

Figure 56 Model layer disc model with deleted constructs 

 

‘Copy & Paste’ of selected model rectangle constructs can be achieved using this workflow example; 
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Begin by selecting the rectangle constructs to be copied; Figure 57 Selection of constructs to be 

copied 

 

Figure 57 Selection of constructs to be copied 

On moving the mouse pointer inside the ‘Drawing Print Preview Panel’ the printer bed ‘Cursor’ X and 

Y coordinates corresponding to the mouse position are displayed to the designer. Once at the 

desired ‘Cursor’ position the designer can mouse right click to display the popup menu to select 

‘Rectangles->Copy & Paste’ to effect the copying of selected constructs to be centred on this ‘Cursor’ 

position; Figure 58 Copy selected constructs to be centred on cursor position Figure 59 Drawing Print 

Preview Panel showing copied model constructs. Figure 60 Model Designer showing result of copied 

constructs. 
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Figure 58 Copy selected constructs to be centred on cursor position. 

 

 

Figure 59 Drawing Print Preview Panel showing copied model constructs. 
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Figure 60 Model Designer showing result of copied constructs. 

 

‘Delta Move’ of selected model rectangle constructs can be achieved using this workflow example; 

Begin by selecting the rectangle constructs to be copied Figure 61 Selection of model constructs to 

move; Figure 62 Move selected constructs centred on Cursor position Figure 63 Drawing Print 

Preview Panel showing moved model constructs. Figure 64 Model Designer showing result of moved 

constructs. 
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Figure 61 Selection of model constructs to move 

On moving the mouse pointer inside the ‘Drawing Print Preview Panel’ the printer bed ‘Cursor’ X and 

Y coordinates corresponding to the mouse position are displayed to the designer. Once at the 

desired ‘Cursor’ position the designer can mouse right click to display the popup menu to select 

‘Rectangles->Delta Move’ to effect the moving of selected constructs to be centred on this ‘Cursor’ 

position; 

 

Figure 62 Move selected constructs centred on Cursor position 
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Figure 63 Drawing Print Preview Panel showing moved model constructs. 

 

Figure 64 Model Designer showing result of moved constructs. 

 

Assemble Model 
On selecting the ‘Assembled Model’ notebook leaf the designer is presented with the ‘Model 
Designer’ canvas that enables a complex 3D model to be constructed from individual 3D model 
layers Figure 65 Model Layer Assembler. 
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Figure 65 Model Layer Assembler 

 

Assemble Model Layer 
Model layers can be individually assembled either into the same assembled model layer and/or 

assembled to form a stack of layers. 

Right clicking the mouse displays; Figure 66 Assemble Model Layer which provides options to 

assemble a model layer at “This Layer” OR “Next Layer” 

Next Layer 

Right clicking the mouse displays; Figure 66 Assemble Model Layer which provides options to 

assemble a model layer at ““Next Layer” 
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Figure 66 Assemble Model Layer 

The designer can choose to assemble a layer model to be placed on top of the current model 

assembled layers height (maximum layers Z position) by selecting ‘Next Layer’ thereby creating a 

new model layer on top of the current assembled layers. 

On selecting ‘Assemble – Next Layer’ the designer is presented; Figure 67 Open Model Next Layer to 

Assemble 

 

Figure 67 Open Model Next Layer to Assemble 
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On selecting ‘Open’ the designer can see the selected model layer assembled into the structure 

under construction; Figure 68 Assembled first Model Structure Next Layer 

Initially ‘Assembled Layer’ displays layer constructs at a rotation of 45 degrees unless the designer 

has applied any rotational and zoom adjustments. The designer can revert to the 45 degrees rotation 

with no zoom by selecting the ‘Reset’ option from the pop-up menu. 

 

 

Figure 68 Assembled first Model Structure Next Layer 

The process can be repeated to assemble another layer with the same Model Layer or an alternate 

Model Layer; Figure 69 Assembled Model Scaffold with First Next Layer and Second Next Layer with 

Circles 
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Figure 69 Assembled Model Scaffold with First Next Layer and Second Next Layer with Circles 

 

This Layer 

Right clicking the mouse displays; Figure 70 Assemble Model Layer which provides options to 

assemble a model layer at “This Layer”  

 

 

Figure 70 Assemble Model Layer which provides options to assemble a model layer at “This Layer” 
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The designer can choose to assemble a layer model at the current model assembled layers height 

(maximum layers Z position) by selecting ‘This layer’  

On selecting ‘Assemble – This Layer’ the designer is presented; Figure 71 Open Model This Layer to 

Assemble 

 

 

Figure 71 Open Model This Layer to Assemble 

On selecting ‘Open’ the designer can see the selected model layer assembled into the structure 

under construction; Figure 72  Assembled first Model Structure This Layer 

Initially ‘Assembled Layer’ displays layer constructs at a rotation of 45 degrees unless the designer 

has applied any rotational and zoom adjustments. The designer can revert to the 45 degrees rotation 

with no zoom by selecting the ‘Reset’ option from the pop-up menu. 
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Figure 72  Assembled first Model Structure This Layer 

 

The process can be repeated to assemble another layer with the same Model Layer or an alternate 

Model Layer; Figure 73 Assembled Model Scaffold with First This Layer with circle and Second This 

Layer with Line 
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Figure 73 Assembled Model Scaffold with First This Layer with circle and Second This Layer with Line 

 

Assembled Layer Construct Manipulation 
Using the ‘Drawing Print Preview Panel’ an designer can move/copy/delete construct(s); Figure 74 

Assembled Layer Constructs –  to reposition them on the print bed prior to printing; Figure 75 

Drawing Print Preview Panel - Assembled Layer Constructs. 

 

Figure 74 Assembled Layer Constructs – Manipulation Selection 
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Figure 75 Drawing Print Preview Panel - Assembled Layer Constructs 

Construct(s) can be selected by pressing and holding the middle mouse button and drawing a box 

around the construct to be selected to be moved/copied. Selected constructs are highlighted in blue 

Figure 76 Assembled Layer - Construct Select. 

Selected construct(s) can be deselected by either pressing the ‘Esc’ key or selecting alternative 

construct(s) 

Selected construct(s) can also be moved using the ‘Left’, ‘Right’, ‘Up’ or ‘Down’ arrow keys; which on 

each key press will move the contruct(s) in the required direction by the distance configured in the 

‘Delta Move’ dialog. 
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Figure 76 Assembled Layer - Construct Select 

On moving the mouse pointer inside the ‘Drawing Print Preview Panel’ the printer bed ‘Cursor’ X and 

Y coordinates corresponding to the mouse position are displayed to the designer.  

A selected construct can be moved to the mouse print bed cursor position by right clicking the 

mouse button and selecting Rectangles->Delta Move from the pop-up menu Figure 77 Assembled 

Layer Selected Construct - Delta Move. On selection of ‘Delta Move’ the construct is moved to the 

required cursor position Figure 78 Assembled layer Selected Construct Moved . 

 

Figure 77 Assembled Layer Selected Construct - Delta Move 
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Figure 78 Assembled layer Selected Construct Moved 

 

A selected construct can be copied Figure 79 Assembled Layer Selected Construct to Copy; by right 

clicking the mouse and selecting the option Rectangles->Copy & Paste Figure 80 Assembled Layer 

Selected Construct Copy & Paste. 

 

Figure 79 Assembled Layer Selected Construct to Copy 
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Figure 80 Assembled Layer Selected Construct Copy & Paste 

Selection of Rectangles->Copy & Paste results in the selected construct being copied and pasted to 

the required printer bed cursor position Figure 81 Assembled Layer Selected Construct Copied. 

 

 

Figure 81 Assembled Layer Selected Construct Copied 
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A selected construct can be deleted Figure 82 Assembled Layer Construct Selected for Deletion; by 

right clicking the mouse and selecting the option Rectangles->Delete Figure 83 Assembled Layer 

Selected Construct Delete. 

 

 

Figure 82 Assembled Layer Construct Selected for Deletion 

 

 

Figure 83 Assembled Layer Selected Construct Delete 
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Selection of Rectangles->Delete results in the selected construct being deleted Figure 84 Assembled 

Layer Construct Deleted 

 

Figure 84 Assembled Layer Construct Deleted 

Trouble Shooting 
 

Model Designer Panel not updating 
Due to precision software calculations employed to create and render the model constructs; there 

can be an increased response time experienced when using the software for complex architectures  

Be patient the software will always complete the model construction. 

 

Cannot load GRAPE files  
Due to cross platform development that enables the GRAPE M1 modelling software to be used both 

on Personal Computers running Windows; and also on the GRAPE S1/S2 bioprinters; there is a 

restriction on how file folder names can be defined. If a file folder contains a space or spaces then 

selected GRAPE model files will not load from these folders. 

Note: File folder names must not contain spaces otherwise the software will fail to read the files 

from these folders. 

 

Drawing Print Preview Panel Still Visible 
The ‘Drawing Print Preview Panel’ is a top level window and can remain visible when the GRAPE M1 

application is minimised for example; this panel can be closed by just mouse clicking anywhere on 

the desktop or performing another windows action such as interacting with another application. 
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Cannot load STL files  
GRAPE M1 cannot load STL files only GRAPE files. However, GRAPE M1 does output GRAPE models in 

STL and GRAPE formats. 

STL Model has missing lines when sliced into G-code 
GRAPE M1 can produce very fine model construction lines and some G-code slicing software can 

have issues with line thicknesses of less than 0.2mm. If this occurs try reconfiguring your G-code 

slicer or/and redraw the model in GRAPE M1 with say a line thickness 0f 0.21mm. 

 

Trademarks and Patents 
Recognised trademarks and protections. 

Patents 
Bio Scaffold patent GB2605009 and PCT/GB2022/000023 – UK Grant 

Additive Manufacturing using Low Viscosity Materials patent applications GB2206780.5 and 

PCT/GB2022/000051 – UK Grant 

GRAPE Data Format and method of 3D Printing patent application GB2206781.3 and 

PCT/GB2023/050890 

Trademarks 
GRAPE UK® - Registered Trademark of Copner Biotech Ltd in the UK under UK00003738838 

RENDERABLE BIOFABRICATION UK® - Registered Trademark of Copner Biotech Ltd in the UK under 

UK00003945866 

Windows® – Registered Trademark of Microsoft Corporation  

 

 


